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1. Extraire le fichier Bentley directement sur le lecteur C:\

2. Ã€ partir du dossier C:\Bentley\
-Extraire le raccourci MTQ_ORD2023_Norme2023-V2 sur le bureau pour OpenRoads Designer.
-Extraire le raccourci MTQ_OBM2023_Norme2023-V2 sur le bureau pour OpenBridge Modeler.
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Historique du document 
Version No Date Commentaires Intervenants 

000 14 mai 2024 Création du document David Thibeault (Bentley) 

    

    

    

    

 

Détails techniques 
Logiciel 

OpenRoads Designer 
 

Version du logiciel 

2023.0.1.11 
 

Nom de la norme 

MTQ_CIV 
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Conventions du document 
Les conventions des styles utilisées dans ce document sont décrites dans le tableau suivant. 

Item Convention Exemple 

Nom d’un menu ou d’un outil Gras, noms séparés par le symbole > • File > Open 

• File > Compress > Design 

Action dans une boîte de 
dialogue 

Gras • Cliquer sur Apply. 

• Cliquer sur le bouton Graphic Select à droite du champ Horizontal Alignment Include. 

• Dans la liste Segment Type, cliquer sur Lines. 

Nom d’un champ dans une 
boîte de dialogue 

Gras Italique • Entrer Route A dans le champ Alignment Name. 

• Cliquer sur le bouton Graphic Select à droite du champ Horizontal Alignment Include. 

• Dans la liste Segment Type, cliquer sur Lines. 

Saisie clavier Gras • Entrer Route A dans le champ Alignment Name. 

Nom d’un fichier Gras italique • Ouvrir le fichier Visualisation3D.dgn dans le dossier \Formation\ 

Chemin d’un fichier Non italique • Ouvrir le fichier Visualisation3D.dgn dans le dossier \Formation\ 

Mise en évidence d’un terme Italique • La bibliothèque de gabarits contient des Gabarits, qui représentent des profils types d’un tracé. 

Nom d’un logiciel, d’une 
application 

Italique • Dans OpenRoads Designer, ouvrir la commande Fichier > Nouveau. 

Méthode de travail 

 

• Méthode pour la création d’un fichier. 
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Terminologie 
Cette partie définit certaines expressions utilisées par le logiciel et de terme à l’usage du domaine des infrastructures routières. 

Item Définition 

ORD OpenRoads Designer 

Point de données Effectuez un clic bouton droit de la souris 

Offset Décalage d’un élément 

Alignement horizontal Tracé 

Alignement vertical Profil en long 

Gabarits Profil en travers typiques 

Réinitialiser Effectuez un clic bouton droit de la souris 

 

Généralité 
Ce document explique le paramétrage du logiciel OpenRoads Designer associés à l’environnement de travail ministériel. 

L’élaboration des fichiers repose sur les dernières normes de dessin du Ministère, sur un ensemble de critères établis par le comité de paramétrage du logiciel OpenRoads Designer ainsi que sur 

les commentaires apportés par les différents utilisateurs. Autant que possible, les standards contenus dans ces fichiers tentent de répondre à la majorité des besoins des utilisateurs à travers le 

Ministère. Il se peut cependant qu’une direction territoriale ait un besoin spécifique. Elle pourra alors soit ajouter ou modifier la configuration de base des fichiers et par la même occasion, faire 

part de ce besoin au comité de paramétrage qui verra à son analyse en vue d’apporter les corrections nécessaires dans la prochaine version des fichiers. 

Les fichiers sont disponibles sur le portail du Ministère à l’adresse suivante : 

https://www.transports.gouv.qc.ca/fr/entreprises-partenaires/entreprises-reseaux-routier/guides-formulaires/Pages/arpentage-conception.aspx 

 

  

https://www.transports.gouv.qc.ca/fr/entreprises-partenaires/entreprises-reseaux-routier/guides-formulaires/Pages/arpentage-conception.aspx
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Fichiers de configuration  
Cette section du document sert à expliquer les différents fichiers de configuration et leur hiérarchie dans l’environnement de travail pour Transports et Mobilité durable Québec. 

Séquence de lecture des fichiers de configuration 
L’image suivante illustre la séquence de la lecture des fichiers de configuration.  Les emplacements indiqués sur cette image sont à titre indicatif seulement.  Ceux-ci peuvent être différents 

d’une direction générale à l’autre.  Lors de l’installation des fichiers de paramétrage, le répondant CDAO pourra déterminer l’emplacement exact de chaque niveau des fichiers de configuration. 

 

 



 
  

10 Configuration - OpenRoads Designer 

 

 

Paramètres de configuration personnalisable 
Le fichier de paramètres de configuration permet de cibler l’emplacement de fichiers de paramétrages personnalisables.  Cela permet de ne pas altérer les fichiers originaux du logiciel.  Il peut 

être modifié lors de l’installation du produit ou en éditant manuellement le contenu.  Il pointe également vers la localisation du fichier des espaces de travail (Workspaces). 

Détails des modifications du fichier 
_USTN_USER_CONFIGURATION_LABEL=  

_USTN_CUSTOM_CONFIGURATION=C:\Bentley\Norme2023-V2\Configuration\ 

  

ConfigurationSetup 
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Espaces de travail (Workspaces) 
Les fichiers CFG pour les Espaces de travail sont utilisés pour définir les environnements liés au secteur d’activité ou un groupe de travail.  Par exemple, un service de projet ou d’arpentage.   

Le fichier CFG indique le nom du groupe. Il contient le nom de l’organisation (correspondant ici à la norme CDAO appliquée), l’emplacement des fichiers de configuration de l’organisation et 

l’endroit où se situe les configurations spécifiques au groupe de travail, c’est-à-dire le dossier du Workspace.   

Les dossiers des espaces de travail sont accessibles en lecture et en écriture pour les usagers d’un même groupe de travail.  Ces pourquoi l’on retrouve, entre autres, la définition des paramètres 

des systèmes de coordonnées. 

Répertoire et nom des fichiers CFG 
C:\Bentley\Norme2023-V2\Configuration\WorkSpaces\MTQ.cfg 

  

Espaces de travail 
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Détails des modifications des fichiers 
Modifications 

CIVIL_ORGANIZATION_NAME = MTQ_CIV 

Ajouts 

_USTN_WORKSPACESROOT = P:\Bentley\V2023\Configuration\WorkSpaces\ 

_USTN_WORKSPACEROOT = $(_USTN_WORKSPACESROOT)$(_USTN_WORKSPACENAME)\ 

Répertoire des fichiers de paramétrage 
P:\Bentley\V2023\Configuration\WorkSpaces\ 
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Organisation (Organization) 
Les fichiers de configuration d’Organisation permettent de définir les paramètres communs à tous, signifiant la norme de dessin de l’organisation MTQ. 

Le terme CIV fait référence à des fichiers de configuration associés au projet routier et STR aux structures. 

 

Répertoire et nom des fichiers 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV.cfg 

  

Organisation 
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Projets (Worksets) 
Les fichiers de configuration pour les Projets (Worksets) permettent de définir les répertoires par défaut d’un projet.  Ils s’appellent généralement par le numéro de projet.  L’emplacement des 

fichiers de configurations CFG et DGNWS diffère de l’emplacement des dessins d’un projet.  Cette manière d’opérer permet de partager les configurations d’une équipe de travail (Workspace), de 

mieux gérer les projets communs en cours, de gérer ceux en attentes et de faciliter l’archivage.   

Répertoire des dossiers de projets 
P:\ 

Répertoire des fichiers de CFG 
P:\Bentley\V2023\Configuration\WorkSpaces\MTQ\WorkSets 

Méthode pour l’archivage d’une configuration de projet 
Lorsqu’un projet est terminé et requiert d’être archivé, il serait préférable de déplacer les fichiers CFG et DGNWS correspondant dans le répertoire : 

P:\Bentley\V2023\Configuration\WorkSpaces\MTQ\Worksets\Archive 

Méthode pour une configuration d’un projet en attente 
Lorsqu’un projet est en attente, il serait préférable de déplacer les fichiers CFG et DGNWS correspondant dans le répertoire : 

P:\Bentley\V2023\Configuration\WorkSpaces\MTQ\Worksets\EnAttente  

Projet 
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Préférences d’interface utilisateur 
Admin > Home > Preferences 

 

Les fichiers de préférences permettent de personnaliser l’imbrication des menus, des boîtes d’outils, de leurs dispositions et des paramètres d’affichage de l’interface de travail du logiciel.  

Lorsqu’aucune configuration n’est établie, les fichiers de base sont copiés du répertoire par défaut des préférences et collés dans le répertoire : 

C:\Users\[NomUtilisateur]\AppData\Local\Bentley\OpenRoadsDesigner\10.0.0\prefs.  Ensuite, ils sont renommés par OpenRoadsDesigner_mtq.[Config].xml. et OpenRoadsDesigner_mtq.upf. 

Catégorie Outils Paramètres 

Language Select Language [fr] French ou [en] English 

Operation Auto-save Design Changes On 

Operation Save Settings on Exit On 

View Options Design Background On - Noir 

View Options - Civil Survey Decorators > Name Location Right Top 

View Options - Civil Survey Decorators > Feature Location Right Baseline 

View Options - Civil Survey Decorators > Elevation Location Right Middle 

View Options - Civil Survey Decorators > Description Location Left Middle 

View Options - Civil Survey Decorators > …Color [255,255,255] 

 

Répertoire des fichiers 
Par défaut, les préférences de l’interface sont pilotées par des fichiers XML et se trouvent dans le répertoire suivant : 

C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\Preference Seeds 

Fichiers XML et UPF 
docking_seed.xml 
explorer_settings_seed.xml 
function_keys_seed.mnu 
group_panel_seed.xml 
preferences.spf 
ribbon_seed.xml 

  



 
  

16 Configuration - OpenRoads Designer 

Prototype (Seeds) 
Un prototype est un fichier modèle qui sert de base pour la création de nouveaux dessins. Il définit les propriétés de base telles que les unités de mesure, les propriétés d’attributs de vue, les 

propriétés de modèle, etc.  Les prototypes sont créés en fonction de besoins spécifiques et peuvent être utiliser comme point de départ pour la création de nouveaux dessins. Les prototypes 

permettent d'assurer la cohérence et l'uniformité de la présentation d'un projet. 

Répertoires des fichiers prototypes de conception 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Seed 

Fichiers DGN 
mtq_seed3D.dgn 

mtq_seed2D.dgn 

Répertoires des fichiers prototypes de mise-en-page (Sheet et Drawing) 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Seed\Sheets 

Fichiers DGN 
mtq_seed2D_drawing.dgn 

mtq_seed2D_sheet.dgn 

mtq_seed2D_design.dgn 

mtq_seed2D_sheetA0.dgn 

 

  



 
 

Configuration - OpenRoads Designer   17 

Paramètres généraux des modèles du dessin 
File > Settings > File > Design File Settings 

 

Catégorie Outils Paramètres 

Civil Formating Station Settings > Format ss+sss.ss 

Civil Formating Station Settings > Precision 0.12 

Civil Formating Station Settings > Equation By Name 

Civil Formating Profile Settings > Vertical Curve Parameter Format Kvalue = Length / (Grade2 - Grade1) 

Angle Readout Format DD MM SS 

Angle Readout Direction Mode Azimuth 

Angle Readout Base – Value North - 90° 

Angle Readout Clockwise On 

Grid Grid Master 1 

Locks Graphic Group Off 

Working Units Linear Units > Format – Master Unit - Label MU – Meters - Vide 

Working Units Linear Units > Sub Unit - Label MU – Millimeters - Vide 

Working Units Linear Units > Accuracy 0.1234567 

Working Units Advanced Settings > Resolution 1000 per Distance Meter 

Working Units Advanced Settings > Working Area 900719925 Kilometers 

Working Units Advanced Settings > Solids Area 10 Kilometers 

Working Units Advanced Settings > Solids Accuracy 10-07 Meters 
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Propriétés des modèles des prototypes de conception  
Home > Primary > Models 

 

Catégorie Outils Paramètres 

General Annotation 1:500 

General Design Scale 500 

General Propagate Annotation Scale On 

General LineStyle Scale Global Line Style Scale 

General Global Line Style Scale 1 

General Update Fields Automatically True 
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Attributs de vues 
Drawing > View > Presentation > View Attributes 
On applique les paramètres suivants pour toutes les vues des prototypes : 

2D 
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3D 
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Systèmes de coordonnées 
Drawing > Utilities > Coordinate System 
Le système de coordonnées fait généralement référence au(x) système(s) utilisé(s) de la position du projet.  Il permet essentiellement à faire le pont entre les données provenant des différents 

systèmes d’information géographiques (SIG). 

Les principaux systèmes de coordonnées utilisées sont : 

 

Répertoire du fichier de favoris XML 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Data\mtq_GeoCoordFavorites.xml 
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Bibliothèques de références (DGNLIB) 
Les fichiers DGNLIB servent à contenir les informations concernant le paramétrage de la norme de dessin en ce qui a trait aux niveaux, aux annotations, aux levés topographiques, aux services 

d’utilités publiques, à l’apparence des éléments graphiques, aux gabarits d’éléments, aux styles de cotations, aux styles de textes, etc.  Il s’agit d’un fichier DGN normal duquel on modifie son 

extension pour devenir DGNLIB.  Les fichiers DGNLIB peuvent être utilisés pour organiser et gérer les éléments réutilisables d'un projet, ce qui permet d'assurer la cohérence et l'uniformité des 

dessins. 

Avant toutes opérations dans ces fichiers, il est fortement recommandé de générer des copies de sureté (backups).  

De plus, la nomenclature est importante et ne devrait pas être modifiée sans motif raisonnable.   

Si le fichier DGNLIB ne porte pas la mention « mtq_ » devant, c’est qu’il s’agit d’un fichier de base du logiciel. 

Lorsqu’on travaille avec une bibliothèque DGNLIB, il est nécessaire de dissocier l’espace de travail et d’éliminer les polices de caractères non nécessaires.  Pour effectuer cette opération, ouvrez 

le Key-In et entrez les mentions suivantes : 

file dissassociateworkset 
delete unused fonts 
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Schéma de définition d’éléments 
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Plateforme de dessin 

Niveaux et filtres (Levels and Filters) 

Répertoire et fichier bibliothèque 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Feature Definitions\mtq_Common General Metric.dgnlib 

Styles de trait (Line Styles) 

Répertoire et fichier bibliothèque 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Feature Definitions\mtq_Common General Metric.dgnlib 

Répertoire et fichier paramétrage 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Line Styles\mtq_lin.rsc 

Méthode pour mettre à jour les style de traits (Line Styles) d’un dessin 
1- File > Settings > File > Line Style Editor. 

 

 
 

2- File > Import > MicroStation Ressource File (RSC).  Sélectionnez le fichier mtq_lin.rsc et remplacez tous les styles de traits de la bibliothèque. 
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Méthode pour convertir et éditer des styles de trait LIN en RSC 
1- Ouvrez la bibliothèque mtq_Common General Metric.dgnlib 

2- File > Settings > File > Line Style Editor. 

 

 
 

3- File > Import > AutoCAD Line Style File (LIN).  Importez le fichier mtq.LIN dans un fichier. 

 

 
 

4- File > Export From DGN.  Exportez le fichier et enregistrer mtq_lin.rsc. 

5- File > Open.  Sélectionnez le fichier mtq_lin.rsc. 
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6- Dans l’éditeur, pour tous les Components de type Stroke, désactivez l’option Single Segment et sélectionnez l’option Corners à ByPass. 

 

 
 

7- File > Save.  Enregistrez er remplacez le fichier mtq_lin.rsc. 

8- File > Import > MicroStation Ressource File (RSC).  Sélectionnez le fichier mtq_lin.rsc et remplacez tous les styles de traits de la bibliothèque. 

Polices de caractères (Fonts) 

Répertoire des polices de caractères 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Fonts  
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Cellules (Cells) 
Les cellules de la bibliothèque mtq_projet.cel sont dessinées en mètres et reflètent une mesure papier.  Elles s’ajustent en fonction de l’échelle de dessin.  Par exemple, un symbole de regard 

circulaire de 1 m de diamètre à 1:1000 est dessiné avec un diamètre de 0.001 unité.  Pour l’échelle 1:500, la mesure du symbole sera de 0.5 m. 

 

La bibliothèque est attachée dans les prototypes (seed) de base. 

 

Répertoire des bibliothèques de cellules 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Cell 
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Éléments textes (Text Favorites – Text Styles – Dimension Styles) 
Les bibliothèques des éléments textes servent à définir les styles de texte et de cotations.  Les favoris de texte permettent d’associer les annotations à des caractéristiques des composantes 

d’un dessin. 

 

Répertoire et fichiers bibliothèque 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ\Dgnlib\Feature Definitions\mtq_Common General Metric.dgnlib 
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Éléments principaux (Features) 

Éléments Plateforme 

Gabarits d’éléments (Element Templates) 

Répertoires et fichier paramétrage 

C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Feature Definitions\mtq_Common General Metric.dgnlib 

Éléments Civils 

Groupe d’annotations (Annotation Groups) 

Répertoire et fichier paramétrage 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Feature Definitions\mtq_Common General Metric.dgnlib 

Symbologies d’éléments (Feature Symbologies) 

Répertoires et fichier paramétrage 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Feature Definitions\mtq_Common General Metric.dgnlib 

Définitions d’éléments (Feature Definitions) 

Répertoires et fichier paramétrage 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Feature Definitions\mtq_Common General Metric.dgnlib 

  



 
  

30 Configuration - OpenRoads Designer 

Modèle de terrain 
Le tableau décrit les différents types d’entités d’un modèle de terrain et les symbologies utilisés. 

Type d’entité Description Symbologie existante Symbologie projeté 

Élévation ponctuelle ou 
Ponctuel (Spot) 

Points (avec des données X,Y,Z) qui n’ont aucun rapport fonctionnel 
à un autre point.  Les points côtés altimétriques (POA) seraient un 
exemple de point de type Ponctuel.  Les éléments de point tels que 
les cellules, les cercles et les chaînes de texte sont des éléments 
MicroStation typiques utilisés pour définir graphiquement les 
élévations ponctuelles.  Les lignes, les chaînes de lignes et les autres 
éléments longitudinaux sont également valides.  Le logiciel crée une 
élévation ponctuelle pour chaque sommet de chaque élément 
longitudinal.  

E-MOD-PONCTUEL P-MOD-PONCTUEL 

Ligne de discontinuité 
(Break Line) 

Les lignes de discontinuités sont utilisées pour désigner des entités 
linéaires telles que les bords de la chaussée, les fonds des fossés, 
les crêtes, et cetera, où un changement brusque de pente se 
produit. Tout élément longitudinal peut être défini comme une 
ligne de discontinuité. Les triangles ne franchiront pas une ligne de 
discontinuité dans le modèle de terrain.  

E-MOD-LIGNE-DISCONT P-MOD-LIGNE-DISCONT 

Ligne de discontinuité 
douce (Soft Break Line) 

Une ligne de discontinuité douce est une ligne de discontinuité. 
Cependant, si elle traverse une ligne de rupture, elle n’affectera pas 
la triangulation et est ignorée.  Par exemple, une voie ferrée (VOF) 
qui traverse une chaussée.  

E-MOD-LIGNE-DISCONT-DOUCE P-MOD-LIGNE-DISCONT-DOUCE 

Courbe de niveau 
(Contour)  

Élément ou ensemble d’éléments de la même élévation. Les 
courbes de niveaux peuvent être utilisés comme données sources 
pour générer un modèle de terrain ou peuvent être calculés 
(dessinés en fonction du modèle de terrain).  L’intervalle ou 
l’équidistance est la différence d’élévation entre deux courbes de 
niveaux adjacentes.  

E-MOD-COURB-NIVEAUX-IMPORT P-MOD-COURB-NIVEAUX-IMPORT 

Trou 
(Hole) 

Zone définie par une figure fermée qui délimite une région où le 
terrain actuel est ignoré et où le terrain sous-jacent est utilisé.  

E-MOD-FRONTIERE-INT-TROU P-MOD-FRONTIERE-INT-TROU 

Frontière 
(Boundary)  

Limite extérieure de la surface. E-MOD-FRONTIERE-EXT P-MOD-FRONTIERE-EXT 
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Type d’entité Description Symbologie existante Symbologie projeté 

Frontière drapée  
(Drape Boundary)  

Limite de surface qui détermine ses élévations en se drapant sur la 
surface sous-jacente. 

E-MOD-FRONTIERE-EXT-DRAPEE P-MOD-FRONTIERE-EXT-DRAPEE 

Vide 
(Void) 

Zone définie par une figure fermée qui délimite une région de 
données manquantes ou de zones obscures. Aucune donnée de 
point ou de ligne de discontinuité située dans la zone vide n’est 
utilisée et aucun triangle n’est créé à l’intérieur des zones vides. Les 
points de la figure fermée sont inclus dans la triangulation et les 
lignes de vide entre les points successifs sont insérées sous forme 
de lignes de drapé sur la surface. Par conséquent, ils ne modifient 
pas la pente ou les élévations de la surface.  Par exemple, un lac ou 
l’intérieur d’un bâtiment.  

E-MOD-FRONTIERE-INT-VIDE P-MOD-FRONTIERE-INT-VIDE 

Vide drapé  
(Drape Void) 

Zone définie par une figure fermée qui délimite une région de 
données manquantes ou de zones obscures. Aucune donnée de 
point ou de ligne de discontinuité située dans la zone vide n’est 
utilisée et aucun triangle n’est créé à l’intérieur des zones vides. 
Pour le type vide drapé, les points de la figure fermée ne sont pas 
inclus dans la triangulation. Les vides sont insérés après la 
triangulation. Les sommets et les lignes vides sont drapées sur la 
surface du modèle de terrain. Même si un utilisateur doit fournir 
une élévation pour les sommets de la figure fermée (exemple à 
l’élévation 0), ceux-ci seront drapés au modèle de terrain à la 
position des sommets.  

E-MOD-FRONTIERE-INT-VIDE-DRAPEE P-MOD-FRONTIERE-INT-VIDE-DRAPEE 

Ligne de discontinuité vide 
(Break Void) 

Zone définie par une figure fermée qui délimite une région de 
données manquantes ou de zones obscures. Aucune donnée de 
point ou de ligne de discontinuité située dans la zone vide n’est 
utilisée et aucun triangle n’est créé à l’intérieur des zones vides. Il 
diffère des types Vide et Vide drapé qui utilisent les élévations de 
sommet de l’élément graphique tandis que les lignes de vide entre 
les coordonnées vides successives sont insérées comme lignes de 
discontinuité. Par conséquent, les lignes de discontinuité vides 
modifient la pente et les élévations de la surface.  

E-MOD-LIGNE-DISCONT-VIDE P-MOD-LIGNE-DISCONT-VIDE 
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Type d’entité Description Symbologie existante Symbologie projeté 

Île (Island) Zone définie par une figure fermée qui délimite une région qui 
contient des données à l’intérieur d’une zone vide. Par exemple, 
des îles au milieu des rivières, des lacs, et cetera.  

E-MOD-FRONTIERE-ILE P-MOD-FRONTIERE-ILE 
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Étiqueteur Civils (Civil Labeler) 
OpenRoads Modeling > Drawing Production > Labels > Civil Labeler 

 

Civil Labeler est un outil qui permet d'ajouter des annotations et des étiquettes à des éléments tels que des alignements, des profils en long, des sections en travers et des modèles de terrain. Il 

offre une grande flexibilité dans la personnalisation des étiquettes en fonction des besoins du projet et permet d'automatiser la création de nombreuses étiquettes communes. 

La création et l’édition des étiquettes s’effectuent à partir d’un fichier DGNLIB dans l’explorateur de fichier, sous la rubrique Label Definitions. 
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Répertoire et fichier bibliothèque 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Feature Definitions\mtq_Common General Metric.dgnlib 
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Arpentage (Survey) 
Survey 

 

Les outils d’arpentage permettent de générer un carnet de note pour importer des données terrains, les éditer, les analyser dans le but de produire un modèle de terrain.  

Répertoire et fichier bibliothèque 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Feature Definitions\mtq_Common General Metric.dgnlib 
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Paramètres de levé topométrique (Survey Settings) 

À partir de Explorer > OpenRoads Standards > Survey Settings, on retrouve les caractéristiques d’importation des levés topométriques. 

Ci-dessous, voici les paramètres spécifiques pour la configuration mtq : 

Paramètres généraux (General Settings) 

 

Points 
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Linking Codes (Code de liaisons des points) 
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Analyse des fichiers de données (Data File Parsing) 
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Valeurs par défaut d’ajustements (Adjustment Defaults) 
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Symbologie d’éléments (Elements Symbology) 

 

Modèle de terrain (Terrain Model) 
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Description des configurations d’importation 

Nom  Importation / Type Description Aperçu de fichier Paramètres 

ASK Fichier ASK  / *.ask Fichier d’importation 
- mtq_ASK.tiw 

Colonnes 
- Nom,YXZ,CODE 

Séparateur 
- Tabulation 

  
mtq *.* Prototype de base  
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Nom  Importation / Type Description Aperçu de fichier Paramètres 

TrimbleCSV Trimble CSV / *.csv Fichier d’importation 
- mtq_Trimble.tiw 

Colonnes 
- Nom, YXZ,CODE 

Séparateur 
- Virgule 

 

 
TrimbleCSV2 Trimble CSV /  

*.csv 
Fichier d’importation 

- mtq_Trimble.tiw 
Colonnes 

- Nom, YXZ,CODE 
Séparateur 

- Virgule 
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Nom  Importation / Type Description Aperçu de fichier Paramètres 

TrimbleCSV3 Trimble CSV /  
*.csv 

Fichier d’importation 
- mtq_Trimble.tiw 

Colonnes 
- Nom, YXZ,CODE 

Séparateur 
- Virgule 

 
 

TuileMNT Tuile MNT /  
*.mnt 

Fichier d’importation 

- mtq_TuileMNT.tiw  
Colonnes 

- Nom, YXZ, Code, Saut, Saut 
Séparateur 

- Tabulation 
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Nom  Importation / Type Description Aperçu de fichier Paramètres 

TXT1 TXT1 /  
*.txt 

Fichier d’importation  
- mtq_TXT1.tiw  

Colonnes 
- Nom, YXZ, Code 

Séparateur 
- Virgule 

 
 

TXT2 TXT - Virgule – 
NomNEZCodeNote /  
*.txt 

Fichier d’importation  
- mtq_TXT2.tiw 

Colonnes 
- Nom, YXZ, Code, Note 

Séparateur 
- Virgule 
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Nom  Importation / Type Description Aperçu de fichier Paramètres 

VisionMNT VisionMNT /    
*.txt 

Fichier d’importation  
- mtq_VisionMNT.tiw  

Colonnes 
- Utilisation de filtres 

Séparateur 
- Tabulation 
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Normes de conception (Design Standard) 
OpenRoads Modeling > Geometry > Standards > Design Standards Toolbar. 

 

Cet outil est utilisé pour valider les normes de conception d’un tracé en plan et d’un profil.  Le paramétrage se fait à partir de l’outil Explorer > OpenRoads Standards > Design Standards dans le 

fichier bibliothèque de référence. 

 

Répertoire et fichier bibliothèque de référence 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ\Dgnlib\Design Standards\mtq_Design Standards.dgnlib 
 

Validation d’un tracé en plan 
Les données de validation dans la catégorie Horizontal, permettent de valider ou déterminer le rayon minimum, le coefficient de frottement latéral et le dévers maximal en milieux rural et urbain 

à haute vitesse et en milieu urbain à basse vitesse pour la conception des courbes horizontales d’un tracé.   

Elles se réfèrent aux données de conception du Tome 1 – Chap.6 des normes sur les Ouvrages Routiers. 

Elles ont été générées en fonction des tableaux suivants : 

➢ Coefficient de frottement latéral en milieu rural et urbain à haute vitesse 

➢ Coefficient de frottement latéral en milieu urbain à faible vitesse 

➢ Rayon minimum en milieux rural et urbain à haute vitesse 

➢ Rayon minimum en milieu urbain à basse vitesse 

  

http://www2.publicationsduquebec.gouv.qc.ca/transports/html/1c6.html
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Validation de profil en long 
Les données de validation dans la catégorie Vertical, permettent de valider ou déterminer les longueurs minimums de paraboles (courbe) d’un profil à utiliser, en fonction d’une vitesse de 

conception. 

Elles se réfère aux données de conception du Tome 1 – Chap.6et Tome 1 – Chap.7 des normes sur les Ouvrages Routiers. 

Elles ont été générées à partir des tableaux suivants : 

➢ Courbure de profil en long minimale pour la distance de visibilité à l’arrêt (S < L) 

➢ Distance de visibilité d’arrêt aux fins de conception (sans l’effet de la déclivité) 

 

Courbes en vues de profil longitudinal 

Le terme anglais Sag est utilisé pour une courbe rentrante tandis que Crest est utilisé pour une courbe saillante. 

 

  

http://www2.publicationsduquebec.gouv.qc.ca/transports/html/1c6.html
http://www2.publicationsduquebec.gouv.qc.ca/transports/html/1c7.html
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Gabarits (Template Library) 
OpenRoads Modeling > Create > Template 

 

Le fichier ITL contient une bibliothèque de gabarits (profils en travers types). 

Cette bibliothèque ne prétend pas répondre à tous les besoins pour la modélisation de chaussée. Il s’agit plutôt d’une base sur laquelle l’usager pourra utiliser et qu’il devra éditer afin d’obtenir 

les caractéristiques de chaussées voulues et adapter selon des conditions de terrain plus variées.  

Les gabarits proposés dans cette bibliothèque peuvent ne pas refléter exactement les normes de conception ou de construction en vigueur. Ils sont plutôt issus de compromis visant à concilier 

ces normes avec la simplicité d’exécution compte tenu du mode de fonctionnement du logiciel de conception OpenRoads Designer. 

La structure de la bibliothèque est composée de catégories dans lesquelles sont contenus des gabarits (Template) regroupés par thématique :  

- Composants, définissant des matériaux ou des éléments surfaciques de chaussée; 

- Conditions de raccordement, définissant des paramètres de conditions de raccordement au sol; 

- Gabarits de surfaces, définissant une infrastructure pouvant épouser la forme d’un modèle de terrain; 

- Gabarits linéaires, définissant des profils en travers typiques se modélisant sur une ligne de référence; 

- Profils en travers, définissant des profils en travers typiques constitués d’agencement entre des composants et des conditions de raccordement.  

Chaque catégorie comporte des sous-catégories pour préciser soit le milieu d’affectation (rural ou urbain) ou le type d’élément (bordures, ouvrages d’art, etc.). 

Répertoire de la bibliothèque de gabarits 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Template Library 

Bibliothèque de gabarits 
mtq_gabarits.itl 
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Méthode pour adapter un gabarit provenant d’un ancien fichier ITL 
Afin de s’assurer que l’affichage fonctionne correctement, voici les modifications à apporter à chaque gabarit d’une bibliothèque : 

1- Tools > Apply Feature Definition to Points.  Appliquez le style correspondant à la couche de matériel correspondant (Ex : Infra).  Effectuez la même opération pour chacune des couches 

à l’exception des points du dessus.  Validez les points à l’aide du bouton Active Template sous la rubrique Point Feature Definitions (carrés orangés autour des points). 
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1- Tools > Apply Superelevation to Points.  Cochez l’option Superelevation Flag aux points affectés par un dévers afin que la valeur soit True.  Validez les points à l’aide du bouton Active 

Template sous la rubrique Superelevation Points (carrés jaunes autour des points). 
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Corridors 
Dévers 
OpenRoads Modeling > Corridors > Superelevation > Create 

 

Le fichier XML contient les tables de dévers permettant d’assigner à chacune des courbes d’un tracé, une longueur de transition et une valeur de dévers en fonction de vitesses de conception et 

d’un nombre de voies.  Il se réfère aux données de conception du Tome 1 – Chap.6 des normes sur les Ouvrages Routiers. 

Il a été généré à partir des données des tableaux suivants : 

➢ Dévers et longueurs de raccordement pour courbes circulaire sans spirale en milieu urbain à faible vitesse, emax = 0,04 m/m 

➢ Dévers et longueurs pour courbes de raccordement (spirale) en milieu urbain à faible vitesse, emax = 0,04 m/m 

➢ Dévers et longueurs de raccordement pour courbes circulaires sans spirale, emax = 0,06 m/m en milieu urbain à haute vitesse et en milieu rural 

➢ Dévers et paramètre minimal de spirale pour courbe circulaire, emax = 0,06 m/m en milieu urbain à haute vitesse et en milieu rural 

➢ Longueurs de transition (Runoff) de 0 % au plein dévers 

➢ Valeur en pourcentage du plein dévers (Full Super) 

Répertoire et fichiers XML  
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Superelevation\mtq_A_devers_04max_table.xml 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Superelevation\mtq_A_devers_06max_table.xml 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Superelevation\mtq_B_devers_06max_runout200.xml 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Superelevation\mtq_C_devers_0406max_penterelative.xml 
 

  

http://www2.publicationsduquebec.gouv.qc.ca/transports/html/1c6.html
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Tables des surlargeurs 
OpenRoads Modeling > Corridors > Edit > Edits > Create Curve Widening 

 

Les tables de surlargeurs sont utilisées pour assigner une surlargeur d’accotement pavé à l’intérieur des courbes d’un tracé en fonction d’un véhicule de type WB-20, d’une vitesse de conception 

et d’un type de route B,C ou D. (largeur de voie de 7.4m,7.0m et 6.6m) 

Les fichiers WID se réfèrent aux données de conception du Tome 1 – Chap.5 des normes sur les Ouvrages Routiers. 

Ils ont été générés en fonction des données du tableau suivant : 

➢ Élargissement de la chaussée dans une courbe en fonction d’une semi-remorque (WB-20) 

Répertoire des fichiers WID  
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Widening 

  

http://www2.publicationsduquebec.gouv.qc.ca/transports/html/1c5.html
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Drainage et services publics (Drainage and Utilities) 
Drainage and Utilities 

 

Les outils contenus servent à modéliser et à analyser le drainage d’un projet routier et les services publics connexes. 

Répertoire et fichier bibliothèque 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Feature Definitions\mtq_Drainage and Utilities Features Annotations.dgnlib 
 

Éléments Plateforme 

Cellules (Cells) 
Les cellules utilisées avec le fichier DGNLIB se réfère au répertoire suivant : 

C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ\Cell 

Styles de textes (Text Styles) 
Présence des styles de textes pour utilisation dans les groupes d’annotations. 

Gabarits d’éléments (Element Templates) 
Voir les méthodes correspondantes pour l’édition et l’importation des fichiers dans la section Outils de paramétrage - Civil. 
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Analyse et rapports 
OpenRoads Modeling > Home > Model Analysis and Reporting 

    

OpenRoads Modeling > Terrain > Analysis 

 

Ces outils permettent de produire des rapports et des analyses d’un projet routier.   
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Devis descriptif (Asset Management) 
OpenRoads Modeling > Home > Model Analysis and Reporting > Asset Manager 

 

L’outil est utilisé pour assigner des propriétés personnalisées à des éléments dans le but de produire, entre autres, des devis descriptifs d’un projet routier, de produire différents types de 

rapports ou d’exporter vers des Systèmes d’Informations Géospatiales (SIG ou GIS) en fichiers de type SHP. 

Répertoire et fichier bibliothèque 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Feature Definitions\mtq_Item Types.dgnlib 
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Distance de visibilité 
OpenRoads Modeling > Terrain > Analysis > Sight Visibility  

 

La distance de visibilité est la distance maximale, mesurée le long de la route en plan et en profil, à partir de laquelle le conducteur d’un véhicule peut apercevoir un point situé à une hauteur 

donnée au-dessus de la route, lorsque sa vue n’est pas gênée par la circulation, par d’autres obstacles latéraux ou par la route elle-même. 

Les paramètres pour les calculs de distances de visibilité se réfèrent au Tome 1 – Chap.7 des normes sur les Ouvrages Routiers. 

Les variables gérant la hauteur de l’œil et de l’objet sont situées dans le fichier MTQ_CIV.cfg. :  

- CIVIL_ANNOTATION_SIGHTDISTANCE_EYEHEIGHT = 1.05 

- CIVIL_ANNOTATION_SIGHTDISTANCE_OBJECTHEIGHT = 0.38 

L’édition du fichier XML s’effectue directement avec un éditeur texte tel que Notepad ++.   

La définition des éléments s’effectue à partir de l’outil Explorer > OpenRoads Standards > Feature Definitions > Sight Visibility. 

Répertoire et fichier XML 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\ Sight Visibility\mtq_Sight Visibility Tables and Equations Metric.xml 

  

http://www2.publicationsduquebec.gouv.qc.ca/transports/html/1c7.html
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Aquaplanage 
OpenRoads Modeling > Terrain > Analysis > Aquaplaning  

 

L'aquaplanage est un phénomène qui se produit quand au moins une roue d'un véhicule perd de l'adhérence par rapport au sol en glissant parfaitement sur une surface aqueuse (flaques, 

chaussée mouillée, etc.). Ce phénomène est accentué en cas de présence d'huile ou d'hydrocarbure sur la chaussée qui réduisent le coefficient d’adhérence. L’outil permet d’évaluer les zones à 

risque d’aquaplanage d’un modèle de terrain et d’assurer un drainage adéquat d’une chaussée d’un projet routier.  

La définition des éléments s’effectue à partir de l’outil Explorer > OpenRoads Standards > Feature Definitions > Aquaplaning. 

 

Profil en travers de différentes routes  
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Mise-en-page (Named Boundary) 
OpenRoads Modeling > Drawing Production > Named Boundaries 

 

La production de modèle dessin en plan, en profil en long et en section en travers ainsi que la production de feuillet s’effectuent à partir de cet outil. 

La configuration de l’espacement entre les sections sont définis via le fichier MTQ_CIV.cfg. 

Les variables sont les suivantes : 

- CIVIL_CROSSSECTION_RT_TO_LT_SPACING 

- CIVIL_CROSSSECTION_TOP_TO_BOT_SPACING 

- CIVIL_CROSSSECTION_SIDE_MARGIN  

- CIVIL_CROSSSECTION_TOP_MARGIN 

Répertoire des bibliothèques de références et fichiers de paramétrage 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Sheet Seeds\mtq_Sheet Seeds_Aire.dgnlib 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Sheet Seeds\mtq_Sheet Seeds_Plan Profil Section.dgnlib 
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Serveurs d’imagerie 
Serveurs par défaut inclus dans le fichier MTQ_WmsServerList.xml. 

Adresse Description Fournisseur Domaine 

http://geocatalogue.mtq.qc/geoserver/wms Géocatalogue MTQ - Direction de 
la géomatique 

MTQ 

http://maps.geogratis.gc.ca/wms/canvec_fr Données topographiques Gouvernement du 
Canada 

Tous 

http://wms.ess-ws.nrcan.gc.ca/wms/toporama_fr Géogratis - Toporama Gouvernement du 
Canada 

Tous 

https://servicesmatriciels.mern.qc/erdas-iws/ogc/wms/Imagerie_Aeroportee_Continue GIIN - Gestion intégrée de 
l'imagerie numérique 

MERN MTQ 

https://servicesmatriciels.mern.qc/erdas-iws/ogc/wmts/Imagerie_Aeroportee_Historique GIIN - Gestion intégrée de 
l'imagerie numérique 

MERN MTQ 

https://ws.mapserver.transports.gouv.qc.ca/swtq Plusieurs sujets liés au 
transport 

MTQ - Direction de 
la géomatique 

Tous 

https://serviceswebcarto.mern.gouv.qc.ca/pes/services/Territoire/RESEAU_GEODESIQUE_WMS/MapServer/WMSServer Points géodésiques MERN Tous 

https://geoegl.msp.gouv.qc.ca/ws/mffpecofor.fcgi Plusieurs sujets liés au 
territoire (LiDAR) 

MFFP Tous 

https://geoegl.msp.gouv.qc.ca/ws/bdga.fcgi Base de données 
géographiques et 
administratives 

MERN Tous 

 

  

https://geoegl.msp.gouv.qc.ca/ws/bdga.fcgi?service=WMS&version=1.3.0&request=GetCapabilities
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Cellules civiles (Civil Cells) 
OpenRoads Modeling > Model Detailing > Create Civil Cell 

 

Les cellules civiles sont utilisées pour définir des gabarits normalisés de géométries soit horizontalement et/ou verticalement.  Il peut s’agir d’entrées privées, de carrefours, de carrefours 

giratoires, des brettelles d’autoroute, etc. 

Répertoire des bibliothèques des cellules civiles  
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Civil Cells 
 

 

Exemples de géométries 
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Aménagement de site (Site) 
OpenRoads Modeling > Site Layout 

 

Les outils d’aménagement de site permettent de créer, planifier et optimiser un modèle de terrain.  Il peut s’agir de construite un stationnement, des plateaux, des entrées privées, des trottoirs 

ou pour trouver le meilleur positionnement pour du remblai/déblai. 

Répertoire de la bibliothèque d’aménagement de site et fichier de paramétrage 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Feature Definitions\mtq_Common General Metric.dgnlib 

 

 

 

 

 

 

Exemple de terrassement 
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Géotechnique (gInt Civil tools) 
Geotechnical  

 

Les outils géotechniques sont utilisés pour importer des données de sondage afin de générer des modèles de terrain de sous-surfaces.   

Répertoire de la bibliothèque pour la géotechnique 
C:\Bentley\Norme2023-V2\Configuration\Organization-Civil\MTQ_CIV\Dgnlib\Color Books 
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Annexes 
Liste des variables du document 

  

Informations – Logiciels / Applications  

• Nom du produit OpenRoads Designer 

• Version 2023.0.1.11 

Informations – Client  

• Nom Transports et Mobilité durable Québec 

• Nom usuel MTQ 

• Norme Courante MTQ_CIV 

• Préfixe des fichiers mtq_ 

• Workspace principal MTQ 

• Workset développement DVLP 

Répertoires locaux  

• Configurations générales C:\Bentley\Norme2023-V2\Configuration\ 

• Workspaces C:\Bentley\Norme2023-V2\Configuration\WorkSpaces 

Répertoires réseaux  

• Niveau - Organisation  C:\Bentley\Norme2023-V2\Configuration\Organization-Civil 

• Niveau - Workspaces P:\Bentley\V2023\Configuration\WorkSpaces 

• Projets P:\ 

Fichiers principaux  

• Cellules mtq_projet.cel 

• Styles de trait mtq_lin.rsc 

• Format papier principal A1 
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Sujets couverts dans ce document 
Table des matières 

Historique du document 

Détails techniques 

Conventions du document 

Terminologie 

Généralité 

Fichiers de configuration 

Préférences d’interface utilisateur 

Prototype (Seeds) 

Systèmes de coordonnées 

Bibliothèques de références (DGNLIB) 

Gabarits (Template Library) 

Corridors 

Drainage et services publics (Drainage and Utilities) 

Analyse et rapports 

Mise-en-page (Named Boundary) 

Serveurs d’imagerie 

Cellules civiles (Civil Cells) 

Aménagement de site (Site) 

Géotechnique (gInt Civil tools) 

Annexes 

Problèmes connus 

Requêtes d’ajouts et de modifications 
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Notes 
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Mise-à-jour des standards à partir d’une bibliothèque DGNLIB 
Explorer > OpenRoads Standards, clic bouton droit Update Standards From dgnlib  

Lorsque l’on désire mettre à jour toutes les informations d’un fichier DGN courant afin de refléter les informations contenues dans une bibliothèque de référence DGNLIB. 
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Outils d’aide à la fabrication des fichiers de paramétrage 
Voici la liste des outils qui aideront à personnaliser les fichiers de configuration de l’organisation : 

- Winzip 

- Notepad ++ 

o Plugins > Compare 

- Microsoft Excel 
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Outils de paramétrage - Plateforme 
Les outils sont disponibles à partir des rubans sous le processus de travail (Workflow) Admin.  Ce ruban est affiché seulement lors de l’ouverture d’un fichier DGNLIB. 

 

Gestion des niveaux et des filtres d’affichage (Levels) 
Admin > Primary > Level Manager 

  

Styles de traits (Line Styles) 
Admin > Styles > Line Styles Editor 
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Styles de texte (Text Styles) 
Admin > Styles > Text Styles 

 

Les hauteurs de texte sont définies par défaut en mm pour les unités métriques.  Les styles de textes définis sont annotatifs; la hauteur et la largeur du texte changent en fonction de l’échelle du 

dessin :  
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Gestionnaire de textes des favoris (Insert Favorites) 
Le gestionnaire de textes des favoris est disponible via l’outil Admin > Interface > Text > Place Text à partir du symbole étoile.  Cela permet de générer du texte avec du contenu contextuel, c’est-

à-dire qui peut utiliser les propriétés des éléments (Civil ou non) afin de les faire afficher.  Ces favoris seront utilisés pour définir les groupes d’annotations (Annotation Groups) ou pour placer des 

étiquettes (Labels) 
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Styles de cotation (Dimension Styles) 
Admin > Styles > Dimension Styles 

 

Styles d’affichage (Display Styles) 
Admin > Styles > Display Styles 

 

Cellules (Cells) 
Admin > Collections > Cells 

 

L’outil ScaleModels.cfg disponible à partir de C:\BentleyDownloads\_Utilities\Scale Models peut être utilisé afin de modifier globalement l’échelle de tous les modèles d’un fichier DGN ou CEL.  De 

plus, les cellules sont annotatives; leurs dimensions changent en fonction de l’échelle du dessin : 
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Gabarits d’éléments (Element Templates) 
Admin > Collections > Element Templates 

 

Outils de paramétrage - Civil 
Les outils de paramétrage Civil sont disponibles en ouvrant l’explorateur (Explorer) à partir des rubans, sous le processus de travail (Workflow) Admin. 

  

Explorer > OpenRoads Standards.  On doit se trouver dans une bibliothèque de références (un fichier DGNLIB) pour pouvoir ajouter ou éditer un élément de cette partie. 
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Symbologies d’éléments (Feature Symbologies) 
Pour que l’importation/l’exportation soit possible dans Explorer > OpenRoads Standards,  

Les configurations suivantes ont été ajoutées dans le fichier de configuration MTQ.cfg : 

- _CIVIL_STANDARDS_IMPORTEXPORT = 1 

- _CIF_ALLOW_EXTENDED_UPGRADES = 1 

Méthode d’exportation de symbologies d’éléments 
1- OpenRoads Designer.  Home > Primary > Explorer.  OpenRoads Standards > Feature Symbologies.  Cliquez bouton droit de la souris Export. 

   
2- Entrez le nom mtq_Symb.xml.  Cliquez sur Save.  Il est important de nommer le fichier tel que prescrit afin de faciliter la gestion des fichiers de configuration. 
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Définitions d’éléments (Feature Definitions) 
Pour que l’importation/l’exportation soit possible dans Explorer > OpenRoads Standards, les configurations suivantes ont été ajoutées dans le fichier de configuration MTQ.cfg : 

_CIVIL_STANDARDS_IMPORTEXPORT    = 1 

_CIF_ALLOW_EXTENDED_UPGRADES    = 1 

Méthode d’exportation de définitions d’éléments 
1- OpenRoads Designer.  Home > Primary > Explorer.  OpenRoads Standards > Feature Definitions.  Cliquez bouton droit de la souris Export. 

 
2- Entrez le nom mtq_Survey_Civil_FeatureDef.xml.  Cliquez sur Save.  Il est important de nommer le fichier tel que prescrit afin de faciliter la gestion des fichiers de configuration. 
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Groupes d’annotations (Annotation Groups) 
Le paramétrage des groupes d’annotations s’effectue en effectuant un clic bouton droit de la souris Manage sur l’élément désiré dans Explorer > OpenRoads Standards > Annotation Groups.  

Les groupes sont classés par type d’affichage puis par type d’élément.  À partir du gestionnaire, on peut créer ou modifier des styles d’affichage pour les éléments civils.   
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Diagramme des Features/Annotations 
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Problèmes connus 
 

Outils Version Type Description Contournement 

Save As 10.9.0.91 Sauvegarde des fichiers en 
format DWG 

Lors de la sauvegarde du fichier, le logiciel affiche 
via le centre de message qu’il recherche le fichier 
Transeed.dgn sur le répertoire D:\. 
 

Ne pas tenir compte de ce message. 

Create 3D Cut 10.9.0.91 Affichage > Vue en profil En effectuant un découpage 3D, le logiciel modifie 
le style d’affichage courant par le style Back. 
 

Effectuer un Undo et refaire la commande. 

Annotations Group 10.9.0.91 Grille des coordonnées en 
plan 

Les coordonnées sont orientées en fonction de 
l’orientation du plan au lieu de l’orientation du 
nord. 
 

Correction ponctuelle de la position des textes. 

Annotations Group 10.9.0.91 Affichage > Vue en section Les cellules n’apparaissent pas sur le niveau 
approprié. 
 

Correction ponctuelle des propriétés des 
cellules. 

Ouvrir un dessin DWG 10.9.0.91-10.11.02.03 Ouverture de fichier en 
format DWG 

Erreur de lecture à l’ouverture du fichier causé par 
les unités du dessin. 

1- Ouvrez le dessin DWG. 
2- File > Settings > File > Design File 

Setttings.  Dans la catégorie Working 

Units, sélectionnez Meters. 
3- Fermez le dessin. 
4- Ouvrez le dessin DWG à nouveau. 

 

Vue en section 
dynamique 

10.9.0.91 Affichage de points dans la 
vue de section dynamique 

Les points disparaissent de la vue lorsqu’on se 
déplace de section en section alors qu’ils devraient 
restés affichés. 

Utiliser un corridor pour afficher les sections 
plutôt que l’alignement lorsque l’on définit une 
vue en section dynamique. 
 

Sheet Index / Propriétés 
d’un projet (Workset) 

10.9.0.91 Fichier DGNWS. Lors de la création d’un Workset dans la fenêtre 
d’ouverture du logiciel, le fichier DGNWS ne 
récupère pas correctement les informations du 
gabarit par défaut.  Les propriétés de projet et 
l’index de feuille ne s’affichent pas. 

1- Fermez OpenRoads Designer. 
2- Effacez le fichier DGNWS du projet. 
3- Ouvrez OpenRoads Designer. 
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Outils Version Type Description Contournement 

Effacer des éléments 10.11.2.3 Corridors, éléments 3D et 
composants 

Certains éléments linéaires 3D et composants 
demeurent dans le dessin même s’ils sont effacés 
graphiquement à partir du modèle 3D.   

1- Ouvrez le gestionnaire des niveaux et 
créez un nouveau niveau TEMP. 

2- Sélectionnez les éléments. 
3- Changez la propriété des éléments 

pour les placer sur le niveau TEMP. 
4- Utilisez le raccourci clavier (key-in) 

LEVEL ELEMENT DELETE TEMP. 
 

 Named Boundary 10.11.2.3 Dessins d’annotations et 
feuillets 

Incapacité de produire des dessins d’annotations à 
partir de l’outil. 

1- Fermez OpenRoads Designer. 
2- Créez un nouveau raccourci du logiciel 

sur le bureau de travail Windows. 
3- Modifiez la propriété Cible du raccourci 

en y ajoutant la mention                          
-RestoreDefaults à la fin du texte.  
Attention! Cette icône réinitialisera 
l’interface du logiciel et en modifiera la 
personnalisation. Elle sert seulement 
lorsqu’une réinitialisation est 
nécessaire.  

4- Ouvrez OpenRoads Designer à partir de 
cette icône. Touchez une touche au 
clavier. 

5- Effacez l’icône (au besoin) pour éviter 
toute confusion d’icônes sur le bureau 
de travail Windows. 
 

Preferences 23.0.1.11 Paramètres Message d’erreur 1114 en lien avec le chargement 
d’une bibliothèque DLL. 

Aucune incidence.  

Dynamic Plan View 23.0.1.11 Géométrie Impossible de fermer la vue dynamique dans la 
barre de vue. 

1- Ouvrez OpenRoads Designer avec 
l’interface en anglais. 
 

AutoTURN 23.0.1.11 Application tierce AutoTURN ne fonctionne qu’avec la version 2024 
du logiciel. 

1- Installez la version 2024 d’AutoTURN. 
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Requêtes d’ajouts et de modifications 
2019-V2 
Version originale du document. 

2019-V2 (Version 1.0) 
• Installation. Possibilité d’installer le répertoire des Worksets à un emplacement différent des configurations de l’organisation.  

• Mtq_seed2D.dgn, mtq_seed2D_design.dgn, mtq_seed2D_drawing.dgn, mtq_seed2D_sheet.dgn, mtq_seed2D_sheetA0.dgn et mtq_seed3D.dgn.  Prototypes.   

o Conservation de deux prototypes uniquement 2D et 3D.  

o Ajustement des attributs de vues. 

• ..\WorkSpaces\MTQ\WorkSets.  Création d’un répertoire Inactifs pour stocker les fichiers CFG et DGNWS de projets qui sont en attentes. 

• ..\WorkSpaces\MTQ\WorkSets.  Création d’un répertoire Archives pour stocker les fichiers CFG et DGNWS de projets qui sont complétés. 

• mtq_Line Styles Metric.dgnlib.  Style de traits.   

o Correction des styles 3D pour glissières. 

• MTQ_2019-V2.cfg.  Correction de la variable MS_DGNLIBLIST_LINESTYLES. 

• Mtq_devers_04max_table.xml, mtq_devers_06max_runout200.xml, mtq_devers_06max_table.xml, mtq_devers_0406max_penterelative.xml.  Création, correction des fichiers de dévers en 

fonction des données en date du 2021 06 15 du Tome 1 – Chap.6 des normes sur les Ouvrages Routiers.  

• Mtq_Design Standards.dgnlib. Correction du fichier des normes de conception en fonction des données en date du 2021 06 15 du Tome 1 – Chap.6 des normes sur les Ouvrages Routiers.  

• Mtq_Gabarits.itl.  

o Ajout du répertoire Urbains et Ruraux (sans AccPav). 

o Ajout du gabarit Rural (Excav). 

o Modification du gabarit Rural et création du gabarit Rural A. 

o Ajout du gabarit Profils en travers > Ruraux 2e classe > Rural (InfraAme)  

o Ajout du gabarit Composants > Structures de chaussée – Rural > InfraAme 

• Mtq_Custom_Menu.dgnlib. 

o Ajout du niveau PAP-TEXTE dans le menu Textes. 

o Ajout du menu Popup via la touche «-». 

o Ajout des outils Trim to Element et Trim to Intersection dans les Outils. 

o Ajout de l’outil Effacer les hachures des sections en travers dans Hachures. 

o Ajout de l’outil Ouvrages routiers dans Outils. 

  

http://www2.publicationsduquebec.gouv.qc.ca/transports/html/1c6.html
http://www2.publicationsduquebec.gouv.qc.ca/transports/html/1c6.html
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• Mtq_Common Features Annotations Levels Elem Temp Metric.dgnlib.  

o Correction et ajouts d’annotations en section. 

o Affichage avec des symboles plus gros en sections et en profil. 

o Ajouts et corrections de Feature Definition. 

• Mtq_Common Text Favorites Metric.dgnlib. 

o Ajouts et corrections de favoris.  

• Mtq_Common Text Styles Dimension Styles Metric.dgnlib. 

o Ajout du style Arial – 1.5mm. 

• Mtq_Survey Settings Metric.dgnlib. 

o Ajouts et ajustement de paramètres Survey. 

o Corrections de Feature Definition. 

• Mtq_WorkSetTemplate.dgnws. 

o Correction du fichier du gabarit Workset. 
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2021 
• Mtq_acadcolor.tbl.  Correction de la couleur 224 dans la table.  

• Mtq_gabarits.itl.  

o Ajout des bordures paramétriques gauche et droite dans le gabarit Rural et Rural – Roc. 

o Ajustement de la largeur des accotements pavés en fonction du point Rive plutôt du point Chev. 

o Ajout des règles d’affichage d’intersections pour les gabarits du répertoire Rural.  

• Mtq_Common Text Styles Dimension Styles Metric.dgnlib. 

o Correction des groupes d’annotations en plan pour les PCC et PCI (CC). 

o Correction de la dimension et de la couleur de la flèche du nord dans les plans et profils. 

o Correction de la précision de la valeur DVA en profil. 

o Correction des groupes d’annotations en profil du positionnement des caractéristique de parabole. 

o Ajout de la définition d’élément Préliminaire de la catégorie Corridor.  

o Ajout des définitions de Berme et de Talus de roc projetés. 

o Modification du gabarit d’élément Lignes\Projetés\Drainage\FOSSE-BORD pour une couleur 150. 

• Mtq_projet.cel.  Correction de l’échelle des cellules suivantes : 

o Clexist, Clotureexist, Clotureproj, Clproj, Emprexis, Emprproj, Pavbordexist, Pavbordproj, Potelecsec, Riveexist, Riveproj, Trotexist, Trotproj 

• Projet.cel.  Ajout de deux cellules point_arial et parcel_arial. 

• Fichiers prototypes.  Correction de la précision des chaînages. 

• Mtq_WmsServerList.xml.  Mise-à-jour des liens. 

• Mtq_2021.cfg.  Correction des variables MS_DWGDATA et MS_DWGSETTINGSFILE. 

• Mtq_Sight Visibility Tables and Equations Metric.xml.  Correction du fichier des paramètres de distances de visibilité en date du 2021 06 15 du Tome 1 – Chap.7 des normes sur les 

Ouvrages Routiers. 

• function_keys_seed.mnu.  Correction de la touche F11. 

CAO-NORME-252218 / TP_DAO-157382 

• mtq(signalisation-N&B).ctb, mtq(signalisation-couleur).ctb.  Ajouts de fichiers CTB pour l’impression des panneaux de signalisation. 

CAO-NORME-252219 / TP-DAO-160182 

• Local_Concept.dgn, Local_Arpent.dgn.  Ajout de fichiers DGN servant à la préparation des devis pour les travaux de conception et d’arpentage. 

o Ajout des niveaux E-FON-CADAS-ANC-LOT et E-FON-CADAS-ANC-NUM. 

  

http://www2.publicationsduquebec.gouv.qc.ca/transports/html/1c7.html
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CAO-NORME-257334 / TP_DAO-251068, CAO-NORME-252221 / TP-DAO-203468, CAO-NORME-252222 / TP-DAO-161385, CAO-NORME-252219 / TP-DAO-160182, CAO-NORME-252221 / TP-

DAO-203468, CAO-NORME-252222 / TP-DAO-161385, CAO-NORME-257334 / TP_DAO-251068 

• PresentConcep.dgn, PresentArpent.dgn.  Correctifs des cartouches. 

CAO-MMTQ-254881 / TP_DAO-226452, CAO-NORME-251979 / TP_DAO-251882 

• Mtq_Common Text Styles Dimension Styles Metric.dgnlib.  Ajout des niveaux suivants :  

o E-FON-CADAS-ANC-LOT 

o E-FON-CADAS-ANC-NUM 

o SIG-IMP 

o SIG-NSR 

o SIG-FOND 

o SIG-PICTOGRAMME 

o P-SIG-PRESCRIPTION 

o E-SIG-PRESCRIPTION 

o E-SIG-DANGER 

o P-SIG-DANGER 

o E-SIG-TRAVAUX 

o E-SIG-INDICATION 

o P-SIG-INDICATION 

CAO-NORME-251979 / TP-DAO-202356 

• mtq_2D_sig-pan-danger.cel, mtq_2D_sig-pan-divers.cel, mtq_2D_sig-pan-indic.cel, mtq_2D_sig-pan-pict.cel, mtq_2D_sig-pan-presc.cel, mtq_2D_sig-pan-travaux.cel.  Ajout des 

bibliothèques de cellules pour les panneaux de signalisation. 
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CAO-NORME-252225 / TP-DAO-160864, CAO-NORME-251979 / TP-DAO-202356 

• mtq_projet.cel.  Ajout des cellules suivantes : 

o servitexis 

o servitproj 

o marq-025.dwg 

o marq-026.dwg 

o marq-027.dwg 

o marq-028.dwg 

o marq-029.dwg 

o marq-030.dwg 

o marq-037.dwg 

2021-V1 
• Mtq_Common Features Annotations Levels Elem Temp Metric.dgnlib.  

o Ajout des Features Definitions (COMP) Surcharge et (COMP) SurInitRed. 

2021-V2 
• Mtq_Common Features Annotations Levels Elem Temp Metric.dgnlib.  

o Correction du code Default ABA par _PTS. 
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2022 
 
CAO-NORME-261428 / TP_DAO-154031 

• mtq_projet.cel.  Ajout des cellules dans la bibliothèque Aéroport : 
o ANEMOMETRE pour Anémomètre (force du vent) 

o ARCAL pour Balise lumineuse d’aérodrome télécommandé (ARCAL) 

o CELOMETRE pour Célomètre (hauteur des nuages) 

o CPDT pour Poste de transformation pour RTIL (CPDT) 

o FEUODAL pour Feu pour système d’approche (ODAL) 

o FEUPAPI pour Feu indicateur de pente d’approche de précision (PAPI) 

o FEUPROTPISTE pour Feu de protection de piste 

o FEURTIL pour Feu d’identification de piste (RTIL) 

o MANCHEVENT pour Indicateur de direction du vent 

o PHAREAERO pour Phare d’aérodrome 

o PIEZOMETRE pour Piézomètre 

o PRISEAERONEF pour Prises d’alimentation pour aéronefs 

o BALISEBLEUE pour Balise de voie de circulation et d’aire de trafic rétro-réfléchissante 

o BALISEJAUNE pour Balise d’intersection d’aire de trafic rétro-réfléchissante 

o BALISEROUGE pour Balise de zone inutilisable rétro-réfléchissante 

o FEUBLEU pour Feu de voie de circulation et d’aire de trafic 

o FEUBORDPISTE pour Feu de bord de piste 

o FEUJAUNE pour Feu d’intersection d’aire de trafic 

o FEUROUGE pour Feu d’obstacle 

o FEUSEUIL pour Feu de seuil de piste 

o PANAERDOUBLE pour Panneau à signalisation aéroportuaire à deux faces 

o PANAERSIMPLE pour Panneau de signalisation aéroportuaire 

CAO-NORME- 261422 / TP_DAO-228229 

• mtq_Common General Metric.dgnlib.  Création de la bibliothèque pour les étiquettes Civil. 

CAO-NORME-262931 / TP_DAO-215514 

• mtq_Custom_Menu.dgnlib.  Remplacement de la description pour le hachurage « immeuble excédentaire » par « immeuble hors emprise ». 
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ADAPTATIONS 

• mtq_SystCoord_Projets.dty.  Ces fichiers, servant à la modification des systèmes de coordonnées, ont été déplacé dans le niveau de configuration Workspace plutôt que Organization, 

permettant la lecture et l’écriture pour une équipe de travail.  

• mtq_civ_2022.cfg.  

o Modification des configurations d’espacements pour les sections en travers. 

o Remplacement des valeurs d’espacement des éléments Civils. 

o Modification des configurations des DGNLIB des Features Definitions.  

o Corrections de certains termes d’annotations. 

o Ajout de configuration de développement. 

o Ajout des configurations AutoTurn. 

• mtq_cc_glisext.dgnlib.  Ajout d’une bibliothèque Civil Cells pour le positionnement de glissières de sécurité. 

• mtq_cc_tumulus.dgnlib.  Ajout d’une bibliothèque Civil Cell pour la conception de tumulus. 

• mtq_Classifications.xml.  Ajout d’un fichier servant à la classification des composants d’un gabarit. 

• mtq_keyboardshortcuts.xml.  Modification du raccourci « - » par « = » pour l’utilisation du menu Popup. 

• mtq_ORD_GPC.xls.  Ajout du fichier permettant de générer un fichier d’importation pour les Parametric Constraints. 

• mtq_geom_1c9_echangeurs.xml.  Ajout d’un fichier de géométries de bretelles d’autoroute pour l’utilisation avec l’outil Geometry Builder. 

• mtq_SUDA_conduites.xml.  Ajout d’un fichier servant de bibliothèque de conduites pour le module de drainage et de services publics. 

• mtq_WorkSetTemplate.dgnws.  Ajout et modification du gabarit de base pour les index de feuilles. 

• mtq_Design Standards.dgnlib.  Correction du fichier des normes de conception. 

• mtq_Common General Metric.dgnlib.  Unification de toutes les bibliothèques de référence pour optimisation de la performance du logiciel. 

• mtq_Custom_Menu_Ribbon.dgnlib.  Ajout du ruban MTQ-Outils dans l’interface du logiciel. 

• mtq_Custom_Menu.dgnlib.  Corrections et améliorations du menu Transports. 

• mtq_Sheet Seeds_Aire.dgnlib.  Unification, corrections, améliorations et ajout de prototypes pour l’outil Named Boundary. 

• mtq_Sheet Seeds_Plan Profil Section.dgnlib.  Unification, corrections, améliorations et ajout de prototypes pour l’outil Named Boundary. 

• mtq_LienSVN.mvba.  Ajout de la macro pour le lien SVN. 

• XSL.  Ajouts, corrections et améliorations de tous les feuilles de styles pour les rapports. 

• PresentConcep.dgn.  Corrections et ajustements des attributs. 

• XML.  Corrections et changement de noms pour les fichiers servant aux dévers. 

• mtq_gabarits.itl.  Corrections, ajouts et adaptation du fichier de la bibliothèque des gabarits. 
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OPENBRIDGE MODELER 

• Ajout des fichiers de paramétrage de base pour les structures fonctionnant avec OpenBridge Modeler. 
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2023 
TP_CONCEPT-265172 

• mtq_Common General Metric.dgnlib.  Correction des symbologies FOS, BOL, CLM et CLO. 

CAO-NORME-264662 / TP_DAO-264647 

• PresentConcept.dgn et PresentArpent.dgn.   

o Corrections d’éléments sur les niveaux Defpoints et 0. 

o Corrections d’anomalies géométriques. 

CAO-NORME-264704 

• PresentArpent.dgn.   

o Corrections des présentations Feuillet A0 Double et Plan de levé. 

CAO-NORME-266832 / TP_DAO-263677 

• Mtq_projet.cel et mtq_Common General Metric.dgnlib.  Ajout de la cellule PICZONESCO et des symbologies correspondantes. 

CAO-NORME-267135 / TP_DAO-258429 

• Mtq_projet.cel et mtq_Common General Metric.dgnlib.  Ajout des cellules BARRIERE-SIGNALEUR et FEU-CIRC-TRAVAUX des symbologies correspondantes. 

CAO-NORME-266839/ TP_DAO-266428 

• Mtq_Common General Metric.dgnlib. 

o Ajout des niveaux E-FON-COMMENT-TITRES, E-FON-COMMENT-ANCIEN-CADAS, E-FON-COMMENT-ANALYSE, E-FON-COMMENT-PLAN-MTQ, E-FON-COMMENT-SERVITUDES et E-FON-

COMMENT-REFERENCES.  

CAO-NORME-267506 / TP_DAO-267228 

• Mtq_Common General Metric.dgnlib. 

o Ajout des niveaux P-STR-ARM-P, P-STR-ARM-L, P-STR-ARM-M, E-STR-ARM-CONSERV-P, E- STR-ARM-CONSERV-L, P-STR-AXE-L, P-STR-AXE-M, P-STR-AXE-P, P-STR-DIM, P-STR-DIM, E-

STR-PONT, E-STR-PONT-CACHEE, P-STR-FOR-M, P-STR-FOR-P, P-STR-FOR-L, P-STR-FOR-CACHEE-M, P-STR-FOR-CACHEE-P, P-STR-FOR-CACHEE-TP et P-STR-FOR-CACHEEX3-M. 
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ADAPTATIONS 

• Mtq_CIV_2023.cfg.  

o Ajustement de la variable pour la reconnaissance du DGNLIB de drainage. 

• Mtq_Common General Metric.dgnlib. 

o Ajout des Feature Definitions _G et _D pour tous les styles présents dans le répertoire Travail. 

o Ajout des Feature Definitions FosCLTravail, FosCLTravail_D et FosCLTravail_G pour la représentation des fossés existants et projetés en plan et en profil. 

o Ajout des styles de composants (COMP) GranulMG56, (COMP) Pierre 0-100mm, (COMP) Pierre 0-200mm, (COMP) Pierre 100-200mm, (COMP) Pierre 200-300mm, (COMP) Pierre 300-

400mm, (COMP) Pierre 300-500mm, (COMP) Pierre 500-800mm. 

o Ajout du style LIGNREF_EXIST. 

o Correction des PCODE portant la mention descriptive (RL) pour l’attribut de modèle de terrain Spot. 

o Correction du niveau E-MOD-SER-ELEC-CONDUITE_3D pour E-MOD-SER-ELEC-CONDUITES_3D. 

o Assignation et correction de la liste de la propriété VBA Feature Macros dans Survey Settings pour toutes les préférences. 

o Ajout du style LIGNREF_EXIST et du groupe d’annotation E-GEO-LIGNE-REFERENC_25m. 

o Ajout des styles GTAD, GTAG, GTBD et GTBG. 

o Correction et ajout d’annotations en profil H V. 

o Modification de l’option de volume pour le style Temporaire. 

o Correction de l’attribut de terrain Break Line pour le style Mur de soutènement. 

o Correction de l’attribut de terrain Do Not Include pour le style Divers. 

o Correction du filtre de niveau Lignes. 

o Ajout des niveaux et styles PIERRE-MAT-RECOUV, PIERRE-REVET-CARAPACE, PIERRE-SOUS-COUCHE-A, PIERRE-SOUS-COUCHE-B, PIERRE-SOUS-COUCHE-C, PIERRE-TAPIS-DRAINANT. 

o Correction des niveaux PAP-FEUIL-INFO, P-MOD-COMP-REVET-PROTEC. 

• Mtq_projet.cel et mtq_Common General Metric.dgnlib.   

o Ajout de la cellule milhumide pour définir la limite d’un milieu humide en section dynamique et du style correspondante. 

o Correction de l’annotation en section dynamique du style PAB. 

o Ajout de la cellule marquexist pour définir la position d’une ligne de marquage en section dynamique et assignation aux styles MDC et MDM. 

o Ajout de la cellule gravbordexist pour définir limite d’un bord de gravier en section dynamique et assignation au style ANB. 

• PresentAccident.dgn.   
o Correction d’éléments sur les niveaux 0. 

• PresentArpent.dgn.  
o L’attributs CRT_SECT_3 a été déplacé sous CRT_ROUT_3 des modèles Feuillet A0 Double et Plan Levé. 

• Mtq_Sheet Seeds_Plan Profil Section.dgnlib.   

o Ajout des prototypes en plan Aire_A1_V2382_Demi et Aire_A1_V2382.  
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2023-V2 
CDAO-NORME-269435/ TP_DAO-269434 

• Fichiers CTB. 

o Correction de la couleur 246 à 10%.  

ADAPTATIONS 

• Mtq_Display Styles.dgnlib. 

o Correction du nom de la bibliothèque. 

o Correction et ajustement des styles commençant par mtq_. 

o Ajout du style d’affichage mtq_Élévations_Transparence.  

• MTQ_CIV.cfg. 

o Modification de la variable MS_WMS_SERVERS par MS_WMS_SERVERS_ORGANIZATION. 

• Mtq_gabarits. 
o Ajout de gabarits dans la catégorie Profils en travers > Réfection de talus. 

o Correction des gabarits Rural (SFond avec Déblai) et Rural (Décapage TerVeg). 

• Mtq_Common General Metric.dgnlib. 

o Correction des étiquettes de l’outil Civil Labeler. 

o Correction des styles Glis_D, CLO, HAI, CLI, MAG et TNA. 
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Notes 
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